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Ich danke Frau Illse Schmiedecke fir ihre nette Erlaubnis, die generelle Struktur ihres Skripts
Hinweise zur Modellierung mit Together fiir diese Lehrunterlage verwenden zu dirfen.

Dieses Manuskript steht allen Teilnehmern der Lehrveranstaltung Software Engineering (SE 1) an der Techni-
schen Fachhochschule Berlin als unterrichtsbegleitendes Lehrmaterial frei zur Verfiigung. Die Nutzung durch
andere Personen oder zu anderen Zwecken bedarf zur Vermeidung mdglicher Verletzungen des deutschen Urhe-
berrechts der vorherigen Inkenntnissetzung und Erlaubnis des Autors.
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46 Einfihrung

Borland Together ControlCenter ist ein (computer aided software engineering
tool), das im Rahmen dieser Lehrveranstaltung zur Modellierung eingesetzt wird. Together
6.2 unterstitzt die UML 1.4 vollstandig und enth&lt auch die meisten Neuerungen der im Jah-
re 2004 verabschiedeten [UML Version 2.0|

Together unterscheidet sich vom Konzept einiger anderer CASE-Tools durch das Leistungs-
merkmal [LiveSource™}, bei dem jedes UML-Diagramm, zu dem es eine Entsprechung im Pro-
grammquelltext geben kann, auch sofort im Quelltext der gewéhlten Programmiersprachedar-
gestellt wird. Jede |Anderung im Diagramm oder im Quelltext wirkt sich dabei sofort in der
jleweils anderen Richtung aus (reverse engineering). In anderen CASE-Tools muss der Ent-
wickler die Generierung des Programmquelltextes aus den Diagrammen (oder umgekehrt) zu
geeigneten Zeitpunkten manuell veranlassen. Der Vorteil des LiveSource™ liegt darin, dass in
Together das Modell und der Quellcode jjederzeit zueinander passen.

Damit dieser Vorteil in Softwareprojekten bis zu deren Auslieferung erhalten bleibt, enthalt
Together komfortable [Enwicklungswerkzeuge], wie einen sprach- und musterkundigen (pat-
terns) [Editor, einen [Debugger], [Testwerkzeuge, einen leistungsfahigen und
Werkzeuge zur Entwicklung von jwebbasierten Anwendungen| und -services. Softwareprojek-
te kdnnen somit johne Medienbruch| vollstandig in Together realisiert werden, ohne dass wei-
tere Entwicklungswerkzeuge ben6tigt werden.

4.7 Modellierung mit Together

Wie beispielsweise aus bekannt, wird in Together mit |Projekten] gearbeitet. Im Rah-
men der Lehrveranstaltung ist unser Fallbeispiel die [Mitfahrzentralel Es wird dafiir in To-
gether |genau ein Projekt erstellt, das von Woche zu Woche fortgeschrieben wird:

Ein Projekt wird er-
v Specify the filename for the project file and choose a location for storing it. Stel It m It dem Ne
Project name un«m|ed1| tpr (legal filename for your Operating System) ‘PI’OJEC'[ EXpert‘ unter

[c

el El File 2New Project
_ _ N Expert...
v Choose the target programming language for simutaneous round-trip engineering,
and the kind of project you want to creste.
Detaut anguoge: [ ays = Der gewiinschte
creation Seenario jektname| wird unter
(® Hew project Project name einge-

() For existing source files
() For existing JARIZip archive

tragen, und das zu-

kinftige Arbeitsver-
zeichnig fur alle zu

erstellenden  Modelle
hlext = | | Finish | | Cancel | Unter LOCBIIOI'I
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Es erscheint ein dreigeteiltes Fenster (siehe Abbildung), das auch Workspace genannt wird.
Unter der Hauptmeniizeile und der Symbolleiste befinden sich links das [Explorer-Fenster]
rechts oben das |Designer-Fenster] und rechts unten das [Editor-Fenster. Weitere Fenster kén-
nen spater hinzugeftigt werden, beispielsweise wahrend der Arbeit mit dem grafischen Ul-
Designer.

Borland Together 6.1 — Mitfahrzentrale

File Edit Search “iew Project RBunm Deploy  Selection  Toaols  Help
| NEEES S e|Xh ﬁl&|@|@|@l§l B | B | |2a &2 |0 big 5B | @) wiorkspace: | Mitfahrzentrale - |
@Explorer 4 O x | |83 Cesigner H O x
@m|og@ | |[BlesvEWIF]
I BF } |E 22 =default=
AN QL | ]
= &8 Mittahrzentrals = .
BE <ciefauts Fl -
K | P
[3] Editar o O x
oy 2= dae B
¥
e [»
@umnledl
=3 [ Prooress 1Y | msert | Lmt | cor1 |

Weitere wichtige [Sichten (views) des Explorer-Fensters, die iiber die einzelnen Reiter dieses
Fensters ausgewahlt werden konnen, sind die Directory-Sicht (das Monitorsymbol), die die
Verzeichnisstruktur der Festplatte darstellt, und die Diagrams-Sicht (drei miteinander ver-
bundene Klassensymbole), die einen Uberblick tiber die verfiigbaren und verwendeten
IDiagrammtypen| gibt.

Sogenannte [default-Diagramme| werden von Together standardmaRig fir jedes Projekt und
jedes Paket erstellt. Sie stellen gewissermafen ein Inhaltsverzeichnis dar. Im Explorer-Fenster
sind sie an dem Symbol mit den vier verbundenen Kastchen zu erkennen. Es empfiehlt sich
nicht, diese Diagramme zur Modellierung zu benutzen, sondern dafiir eigene Diagramme zu
erzeugen!

Die Projektstruktur vorgeschlagene
Paketstruktur

— L ey — y Das Together-Projekt soll

i [ :
[ e e Rahmen der Lehrveran-
" -l [} .. sulung plle Diagramme
'éfecidsedmfdeb i . TTesm | ... |und den Quelltext] aufneh-
| classtogers | -~ men. Daher ist es sinnvoll,

Analyse = | . |UseCaseModels |- - - - - - . . .} - - - ... .. . . -

= B pesign ’ 2 | | | Dynamichodels | 00D - Dbereits zu Beginn gine gute
R A= _ [Struktur) festzulegen, die im
- laufe des Projekts keine un-
erwarteten Probleme er-
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zeugt. Es wird daher empfohlen, zunachst die oben abgebildete aufzubauen.

Together-Projekte sind in gegliedert, die ihrerseits [Diagramme und Programmquell-|
enthalten. Pakete entsprechen Java-Paketen und sind gleichermalRen Namensraume.

Ein neues Paket wird erzeugt, indem iiber das [Kontextmenii des default-Pakets im Explorer-
Fenster (mit rechter Maustaste darauf klicken) New >Package gewahlt wird, oder alternativ
das Symbol New Diagram im Designer-Fenster geklickt und darin ein neues Paket ausgewahlt
wird.

Innerhalb des Projektbaumes sind nun zwei Pakete namens |Analyse| und [Design| zu erstellen.
Das Analysepaket enthalt drei weitere Pakete namens |UseCaseModels|, [ClassModels und
IDynamicModels, Namen miissen generell java-konform| sein, diirfen also keine Sonderzei-
chen oder Umlaute enthalten. Bezeichner wie static mussen unbedingt vermieden werden, da
es sich bei diesen um reservierte Java-Schlisselwdrter handelt, die ansonsten dem Compiler
bei der Quelltextubersetzung Probleme bereiten wiirden.

Ein neues Diagramm anlegen

Das erste im Rahmen der Lehrveranstaltung angelegte Diagramm ist das [UseCase-Diagramm.
Es soll Geschaeftsprozesse heiffen und im Paket Analyse.UseCaseModels erstellt werden.

Im Explorer-Fenster wird des

Paket UseCaseModels mar-
kiert und dann Uber dessen

unL || Together |

iz @ N
£ W Ao = © Kontextmenii
Class Use Caze Sequence Collaboration Statechart NeW 9D | ag ram 9use CaSE
&% 2] 7 das gewunschte Diagramm
Activity ComponertDisgr sm Deployment erstel It Der Name Wl rd |m
Digram name: [Geschastisprozesse | Feld Diagram name eingetra-
Package name: 'JseCaseModelS |ﬂ gen .
I Include in current diagram A A . .
Descrigton: Wird das Diagramm irrtim-

lich im falschen Paket erstellt,
so lasst es sich auch im Nach-
hinein noch per
verschieben. Dazu muss aller-
dings zun&chst in den To-
A gether-Einstellungen die Mog-

lichkeit des Drag’n’drop akti-
viert werden. Dazu ist Uber das Hauptmen( die Option Tools 2Options 2*Default Level aus-
zuwéhlen. Innerhalb der Sektion General im Default Options-Fenster befindet sich die Ein-
stellung Enable Drag-and-Drop, welche zu aktivieren ist.

Click Ok to create a new disgram.

| Ok || Cancel || Help |

Achtung: Together ,,verschluckt” sich beim Verschieben recht gern. Es empfiehlt sich daher,
vor grolieren Verschiebeaktionen das Projekt mittels File >Save All abzuspeichern. Regelma-
Riges Abspeichern kann ibrigens auch sonst nie verkehrt sein...
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Im neuen Use Case-Diagramm wird nun ein [Use Case mit zwei Akteuren| modelliert. Dazu
muss zuné&chst das soeben erstellte Diagramm mittels Doppelklick im Explorer-Fenster geoft-
net werden.

R YT ———y - .- Das gewunschte Symbol des

PR -~ - [Akteurd (Actor), des [Ge]
b AR e E i : schéftsp_rozessesI (Use Case),
N — = - der Beziehung (Communica-

: tes) und der [Systemgrenze

. Mitarbeitet  (System Boundary) in der
... ..... Werkzeugleistd am linken
"""""""""""" Rand des Designer-Fensters
wird jeweils ausgewdhlt, und durch Klick in das Dia-

gramm erstellt (Drag’n’drop geht hier leider nicht...).

Anbistar "N

Alle anderen Diagrammtypen, die Together anbietet,
werden auf die gleiche Weise bedient.

T

Ny b

Am gunstigsten beginnen Sie zunachst mit dem hier abgebilde-
ten Uberblicksdiagramm und erweitern dieses sukzessiv um die
im Rahmen lhres eigenen Projekts identifizierten Anwendungs-
falle.

Diagramme kopieren

Oft besteht der Wunsch, [Diagramme zu kopieren|, beispielsweise um in einem zweiten Dia-
gramm weitere Details hinzuzufiigen. Dazu enthélt im Explorer-Fenster das Kontextmeni
jedes Diagrammtyps den [Eintrag Clone], mit dem eine des Diagramms erzeugt
werden kann. Das entstehende Diagramm ist unabhangig vom Original, d.h. Modifikationen
des einen bleiben ohne Auswirkung auf das andere. Achtung: dies gilt nicht fir Klassendia-
gramme, dazu jedoch spater mehr!

Diagramme drucken oder als Grafik exportieren

Uber das Dateimenii File >Print Diagram... lassen sich |[Diagramme drucken|. Damit hierbei
nicht unniitz Papier verschwendet wird, missen folgende Einstellungen gewahlt werden: Im
ersten Dialogfenster die Eigenschaft Current, damit nur das augenblickliche Diagramm ge-
druckt wird. Dann die Schaltflache Print Options... klicken und im sich ¢ffnenden Fenster
Diagram options: Print die Einstellung Fit to page (sie steht in der vorletzten Zeile) auswah-
len. Das augenblickliche Diagramm wird dann optimal gedruckt.

Diagramme konnen auch jals Grafikdatei exportier werden, um sie beispielsweise in Word-
dokumente einbinden zu kénnen. Dies geschieht iber das Menu File 2Save Image
—-><Format>. Die entstehende Grafik wird standardmaRig im selben Verzeichnis gespeichert
wie das Diagramm selbst, im vorliegenden Fall also unter <Arbeitsverzeichnis>\Analyse
\UseCase. Aber: alle Together-Diagramme liegen ohnehin bereits im WMF-Format vor. Die-
ses kann auch ohne die beschriebene Konvertierung direkt in Word eingebunden werden.
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4.8 Klassendiagramme und LiveSource™

-------------------- Ein neues [Klassendiagramm wird

Kunde . -+.-.-...[ person |- natirlich in unserem Paket ClassMo-
RN rment . I . dels erstellt. Danach wird beispiels-
. . weise eine Klasse (Class) Kunde und

R . eine Klasse Person eingezeichnet, und

T * die beiden Klassen werden uber eine

(Generalizati-
on/Implementation) miteinander verbunden. Uber das Kontextmenii New =>Attribute der Kun-
den-Klasse wird noch ein kundennummer definiert. Markieren Sie nun die Klasse
Kunde. Im Editor-Fenster wird sofort der entsprechende Programmquelltext dieser Klasse
angezeigt. Wie man sieht, erweitert sie die Klasse Person (,,public class kunde extends Per-
son““) und enthélt ein privates, typnumerisches Attribut kundennummer. Wird die Klasse Per-
son markiert, wird stattdessen ihr Programmquelltext im Editor angezeigt.

Wird der [Typ des Attributs im Editor-Fenster beispielsweise von int in string geandert, wird
sofort die entsprechende Klasse im Klassendiagramm aktualisiert. Die sichtbare Ubernahme
geschieht allerdings erst nach einen Klick in das Diagramm oder durch Druck auf die Taste
F5, (Update im Kontextmeni) wéahrend der Fokus sich bereits im Diagrammfenster befindet.

Da Klassendiagramme \programmquelItextbasierte Diagramme\ sind, erscheinen die Modell-
elemente der Klassen Person und Kunde auch im Explorer-Fenster.

Bitte beachten: wenn von einen Klassendiagramm eine [Kopie mittels Clone| erstellt wird,
dann wirkt sich jede Veranderung| des einen Diagramms auch auf das andere Diagramm aus,
da sich beide Diagramme auf |denselben Programmquelltexy beziehen!

Elemente ausblenden

Sollen in einem geklonten Diagramm [einzelne Elemente ausgeblendet werden, ohne dass sie
tatséchlich aus dem Modell entfernt werden sollen, ist Delete from View im Kontextmenu des
Elements zu verwenden. Das Element (evtl. mit all seinen Beziehungen etc.) kann jederzeit
wieder mittels Drag’n’drop aus dem Explorer-Fenster in das Diagramm dargestellt werden.

Namensraume

Wird in einem néchsten Klassendiagramm versucht, eine weitere Klasse Kunde anzulegen,
kommt es zu einer [Fehlermeldung, da diese Klasse bereits existier. Zur Lésung gibt es zwei
Méglichkeiten: Entweder mochte man die Klasse erneut in ein Klassendiagramm integrieren,
und wahlt dazu im Kontextmenu der Klasse innerhalb des Explorer-Fensters Add as Shortcut.
Man erhélt eine Verknlpfung mit der schon vorhandenen Klasse. Oder man bendétigt einen
Ineuen Namensraum| (name space), in dem der Name Kunde noch nicht bekannt ist, d.h. man
legt das neue Diagramm in einem anderen Paket an.
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49 Oberflachenprototypen mit dem Ul-Designer

Together verfiigt iiber einen [leistungsféhigen Ul-Designer] (user interface designer), mit dem
Swing- und AWT-Oberflachen fiir Java grafisch erzeugt werden kénnen. Dieser ist sogar so
weit konfigurierbar, dass mit ihm Oberflachen weiter bearbeitet werden kdnnen, die bei-
spielsweise mit Borland JBuilder oder NetBeans erzeugt wurden.

Wir werden den Ul-Designer jedoch nur als reines Zeichenwerkzeug einsetzen, um einen
explorativen Prototypen der Benutzungsschnittstelle zu erzeugen.

Um eine neue [grafische Oberflache zu generieren), bendtigt man zunachst eine Klasse Mein-
Fenster, die JFrame erweitert. Dazu wird in einem neu zu erstellenden Paket GUI eine Klasse
erzeugt, jedoch nicht wie bisher Gber New ->Class, sondern tiber New ->Class by Pattern... In
dem sich 6ffnenden Fenster Choose Pattern ist innerhalb der Ul Components die Klasse
JFrame auszuwahlen. Alternativ kann auch aus dem Dateimeni heraus File >New ->User
Interface 2>Swing Containers ->JFrame aufgerufen werden.

Fiir den Fall, dass sich der Ul-Designer nun von allein 6ffnet], kann er iiber das entsprechende
Symbol Ul Designer in der Symbolleiste des Designer-Fensters manuell aktiviert werden,
oder Uber das Hauptmeni View 2>Designer View Ul Designer.

I.'-ornd Togetherﬁ.'T —nanmentrale EE® I m DeSig ner-
File Ecit Search “isw Project Run Deploy Tools  Help . .
BExES|(vc|xhE |6 NEKED| ||| %R | @ wormsce Mianzemde v Fenste_r ISt nun wie
O Explorer O x ’E Designer oo x||E H X abgebl Idet ZU'
=TTl L | aace 2|l nachst eine graue,
=
a[alE e_-l: = = | A leere ljava'
e B " || [Oberflache zu se-
= Analyse H
B s » hen. Rechts befin-
kit | __ | detsich eine groe
" . = || Auswahl an
gluasiszrame ‘SWi ng- Und AWT"
B8 ClassMocels =
<l [Komponenten),
= e ~ sowie -Containern|,
Proper‘t::nLEvemsll — Checkox die per Mausklick
ackground : %ﬂ au Sg ewah It un d
ursar java. Gt Cursor] @ Editar ) % nice H H H
HefaulClos=Opera... HDE_ON_CLOS MR R T TIEE] o Ch - mit e|ne-m We'!:ere-n
ort _~ llme ol ] Mausklick beliebig
e || ISt i s A G|l = | auf der Oberflache
conlmage . - . : g == . .
ot Eleiielayo B ; Epublic class CustomFrame extends JFrame ! SA::Z;GEan‘ platZIert und In der
ocale &_DE ?n #%% Creates new form JFrame */ o | — GroBe Verandert
enuBar = I [HEE [» Syving Contal... A
Press Cirl+Aft+ to finish editing and cl.. [ CustomFrame java Swing Menu Werden kon nen.
I thiz Bounds: Lett = 0 Top = 0 Width = 485 Height = 300 | Pragrass | ||| Inzert L & Cal: 1

Sollte das Symbol des Ul Designers berhaupt nicht vorhanden sein, so kann es Uber
Tools 2Activate/Deactivate Features... 2Together Features Ul Builder aktiviert werden.
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Der Inspektor

Um |vollstandige Kontrolle iiber das Layout der Oberflache zu erhalten, muss das Layout der
JFrame-Klasse noch von BorderLayout auf NullLayout umgestellt werden. Dazu ist das JFra-
me-Objekt zu markieren (durch einen Klick irgendwo in die noch leere Java-Oberflache), und
im Reiter Properties des unterhalb des Explorer-Fensters liegenden (inspector) die
Eigenschaft layout in NullLayout zu andern.

Sollte der Inspektor (berhaupt nicht sichtbar sein, so kann er Uber das Hauptmeni
View -*Main Panes Properties... aktiviert werden.

Das Properties-Fenster des Inspektors ist der [Schliissel zur Gestaltung der Oberflache| Dort
konnen fir jjede Komponente und jeden Container] die Eigenschaften wie beispielsweise Farbe
und Beschriftung festgelegt werden.

Die Verwendung erfordert natiirlich Kenntnisse iiber die Eigenschaften und das Verhalten| der
einzelnen Java-Komponenten und -Container (wie beispielsweise JTabbedPane), die im
Rahmen dieser Lehrveranstaltung jedoch nicht thematisiert werden.

Ausfihren der Oberflache

Um die Oberflache [als unseren explorativen Prototypen der Benutzungsoberflache ausfiihren
zu kénnen, muss zunachst noch eine [Main-Methode generiert werden. Dazu ist erst die dafiir
gewinschte Klasse zu markieren, und in ihrem Kontextmeni New ->Member by Pattern...
auszuwahlen. Im sich 6ffnenden Fenster Choose Pattern - Main method ist dann der Eintrag
Main method zu wéahlen. Die Main-Methode wird nun automatisch generiert.

Im Rumpf der Main-Methode muss als allererstes [ein Objekt der Klasse] MeinFenster instan-
ziiert und im Anschluss jsichtbar gemacht werden, da sonst nichts zu sehen sein wird:

new MeinFenster().setVisible(true);

Jetzt kann die Anwendung mit Hilfe der Schaltfliche Run auf der Symbolleiste oder durch
Druck auf die Taste F9 ausgefthrt werden.

Es geht nicht...

Sollte die Darstellung des Fensters sich nicht verhalten wie erwartet, so wird dies hochstwahr-

scheinlich zum einen daran liegen, dass die [Operation pack() im Konstruktor der Fensterklas-|
aufgerufen wird. Sie sollte auskommentiert werden.

Zum anderen bewirkt eine |peliebige GroBenanderung des Fensters im Ul-Designer, dass es
im Programmquelltext mit einer expliziten GroRenangabe versehen und auch so angezeigt
wird, und nicht mit der minimalen GroR3e. Dies kann auch manuell durch das Einfugen der
Zeile
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setBounds(new java.awt.Rectangle(left, top, right, bottom));

in der Operation initGUI() des Quelltextes geschehen, wobei left, top, right und bottom fir die
gewilinschten Ausmalie stehen.

Eine zusatzliche Zeile

setLocationRelativeTo(null);

in initGUI() bewirkt ferner leine bildschirmzentrierte Ausgabe] des Fensters.

Andererseits kann das unerwartete Verhalten einer Anwendung freilich auch unendlich viele
andere Griinde haben...

Ereignisbehandlung hinzufiigen

Unsere Anwendung ist leider noch vollstandig reaktionslos (das Fenster l&sst sich zumindest
schliel3en, was ja auch schon mal eine Reaktion ist).

Nach der Erstellung und Markierung einer Komponente, beispielsweise eines Buttons, kann
im Reiter Events des Inspektors eine Routine zur Ereignisbehandlung definiert werden, bei-
spielweise actionPerformed. Mit einem Klick auf diesen Typ der Ereignisbehandlungsroutine
erscheint ein generischer Name der Routine als VVorschlag im rechts davon liegenden Text-
feld, im Beispiel buttonlActionPerformed. Nach erneuten Klick auf den Typ actionPerformed
wird diese Routine im Programmaquelltext erzeugt und registriert. Ihr Rumpf ist leer. Die Zeile

buttonl.setBackground(new jawa.awt.Color(255,255,255));

fiihrt beim Klick auf die Schaltflache zu ihrer eigenen Farbénderung. Wie einfallsreich...

4, 10 Weitere Together-Einstellungen

In Klassendiagrammen der UML ist die Darstellungsreihenfolge |Attribute, dann Operationen)
in  Together jedoch  Operations, then Attributes. In den Einstellungen
Tools >Options Default Level ?Source Code -Order kann die Eigenschaft Position mem-
bers auf Attributes, then Operations geandert werden.

In Klassendiagrammen der UML zeigt die [Pfeilrichtung einer Assoziation| die Richtung der
Assoziation an. In Together wird jedoch keine Pfeilspitze angezeigt. In den Einstellungen
Tools 20ptions 2Default Level 2Diagram ->Associations kann die Eigenschaft Draw direc-
ted auf All gedndert werden.

Fur die Weiterverarbeitung der in Together erstellten Diagramme ist es oft nitzlich, ihre
Darstellung| auszuschalten. Dies geschieht Uber Tools 2Options *Default Level >Diagram.
Die Eigenschaft 3D look kann darin deaktiviert werden.
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